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OPERATING
INSTRUCTIONS

Please read these Operating Instructions
before using the unit and save for future
reference.

FOR OPERATION ASSISTANCE,
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User License Agreement for Kyushu Matsushita Electric SOFTWARE
A. Grant of License.
1. You shall not copy or sublicense to any third party. You may make one copy of the SOFTWARE solely for a
back-up purpose.
B. Limitations Use
1. You shall not rent or lease the SOFTWARE to any third party. You may permanently transfer all of your
rights, provided you retain no copies, you transfer all of the SOFTWARE including all component parts, the
media and printed materials. And the recipient agrees to this term.
2. You shall not disassemble, decompile or reverse engineer the SOFTWARE.
C. Copyright.
1. The SOFTWARE and the accompanying printed materials are owned by Kyushu Matsushita Electric Co.,
Ltd or its suppliers and protected by copyright laws. You may have registered rights by purchasing the
SOFTWARE; the Copyrights and all other rights in the SOFTWARE shall remain with us or our suppliers.
D. Limited Warranty.
1. We disclaim all implied warranties including any warranty or merchantability or fitness for a particular
purpose. The limited warranty does not apply if the failure of the diskette defaulted from accident, abuse or
misapplication of the SOFTWARE and shall not extent to anyone other than the original user of the
SOFTWARE.
2. You shall not alter, modify the SOFTWARE. We are not liable for any loss or damage caused by arising out
of the SOFTWARE.

F. Termination
1. You may terminate this Agreement by destroying the SOFTWARE, accompanying printed materials and any
copy or returning them to us.
2. This Agreement will also terminate if you fail to comply with any of the terms of this Agreement. You must
then promptly destroy the SOFTWARE, accompanying printed materials and any copy or returning them to
us by your own charge.
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E. Liability
1. The SOFTWARE is licensed on an AS IS basis without warranty of any kind, or conditions, express or
implied, including fitness for particular purpose.
The entire risk as to the results and performance of the SOFTWARE is assumed by you. Neither we nor our
suppliers shall have any liability to you or any other person entity for any indirect, incidental, special or
consequential damages whatsoever, including but not limited to loss of revenue or profit, lost or damaged
date or other commercial or economic loss, even if we have been advised of the possibility of such damages
or they are foreseeable; or for claims by a third party.
2. Our maximum aggregate liability to you shall not exceed the amount paid by you for the SOFTWARE.

Setup (PC)
Connecting to a computer!
To run the Panasonic Multi-Function software (PANA LINK), you need the following software and hardware.
CPU:

An IBM compatible personal computer with a 486 or higher processor (Pentium is
recommended.)
Basic Software:
Microsoft® Windows® 95 or Windows 98 (Windows 3.1/3.11*—printer driver only)
Memory Minimum: 16 MB (32 MB or more is recommended)
Hard disk:
More than 40 MB available space
Other:
Parallel port
Panasonic Multi-Function fax machine
*Microsoft Windows operating system Version 3.1/3.11 (hereafter Windows 3.1/3.11)
Connect your personal computer to the fax machine as follows:

Printer cable
(Parallel cable)

To parallel port

Caution:
≥When connecting the fax machine to your computer, use the included printer cable for reliable data
communications and compliance with FCC rules.
≥Do not connect the printer cable to the serial port on the computer. This may cause damage to your fax
machine and computer.
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Setup (PC)
Installing the PANA LINK software!

1
2

Start Windows 95 or Windows 98 and close all
applications.

3

The installation will automatically start.

4

Follow the instructions on the screen until all
files have been installed.

5

Be sure to read a README file for more
information.

Insert the included CD into your CD-ROM
drive.
≥The language dialog box will appear.
Select the desired language that you use
with this software. Then click [OK].

PC Software

≥If the language dialog box does not appear:
The installation will automatically start.
≥If the language dialog box does not appear
and the installation does not start
automatically:
Click Start, choose Run... . Type “d:\setup”
(where d: is the drive letter of your CD-ROM
drive). Click OK.
(If you are not sure what the drive letter is for
your CD-ROM drive, please use Windows
Explorer and look for the CD-ROM drive.)

≥The README file contains the following
information:
1. Install/uninstall PANA LINK for
Windows 95/98.
2. Install/uninstall KX-FLM600/650 for
Windows 3.1.
3. Print and Scan from Windows 3.1.
4. How to feed recording paper manually.
5. How to use Help.
6. Acrobat Reader.
7. ECP Problems.

Note:
≥For detailed instructions on PANA LINK software, use the Help function.
≥The screens shown in these instructions are from Windows 95.
Windows 3.1 or 3.11 users:
≥If you are using Windows 3.1 or 3.11, follow these steps to install the software.
1. From the Program Manager, click File, choose Run... .
2. Type “d:\setup” (where d: is the drive letter of your CD-ROM drive).
3. Click OK.
≥The printer driver only is available. Please read the README file (README.WRI) on the CD-ROM for more
information.

≥The display illustrations may differ slightly from the display of the actual product.
≥The display details are subject to change without notice for improvement.
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Setup (PC)
Activating the PANA LINK software!

1
2

Click Start.

Point to Programs, point to PANA LINK and click
PANA LINK.
≥The PANA LINK main panel will appear.

Send a fax
To send a file
created on the PC.

Scan
To create an image
file by scanning the
document set in the
fax machine.

Copy
To make a copy of the
document set in the fax
machine.

Print
To print a file
created on the PC.

To

Display

Dial keypad

To make a
phone call.
Redial
To redial the last
number dialed.
Pause
To insert (a)
pause(s) in the
telephone number.

Add. book
To store and view
information in your
address book.
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To delete one figure To stop fax
of a telephone
transmission or
number.
reception.
Comtn. Log
To display the record of
transmitted/received
facsimile documents and
manage the documents
waiting to be sent.

Viewer
To display an image
sent or received with
PANA LINK.

Setup
To set PANA
LINK options.

To start fax
transmission or
reception.
Help
For detailed
instructions on
PANA LINK
software.

T
s
n

Setup (PC)

To exit PANA LINK.

.

To minimize
to an icon.
To minimize.

To register or change data
in the one-touch memory.
PC Software

To delete the data in the
one-touch memory.
To switch to the telephone
numbers.
To switch to the fax
numbers.
One-touch dial
Reception icon
Displays the number of the
received documents which
have not been viewed yet.

n or

To delete a
selected telephone
number.

n
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Setup (PC)
Setting up PANA LINK!
The items which can be set are the Line, Transmission, Reception, System, User Information and Cover Page.

1

2

Open the PANA LINK main panel.

Click [Setup] in the main panel.
≥The Setup dialog box will be displayed.

Note:
≥For further details, use the Help function.

8

3

Change the set value in the Setup dialog box.
≥To change the value without closing the
window, press [Apply].

4

Click [OK].

Setup (PC)
Setting user information!
The information set here is used on your cover page and the header that prints on the top of each page you
send from the PC.

1

2

Open the PANA LINK main panel.

3

Click [User\Information].

4

Enter your information for each item.

5

Click [OK].

≥The User Information dialog box will be
displayed.

Click [Setup] in the main panel.
≥The Setup dialog box will be displayed.

PC Software

9

Printer
Printing documents created on the PC!
You can print documents created from a Windows application.
Select Panasonic Fax Machine “Panasonic KX-FLM600/650” as the active printer.

Printing from Windows applications
For example, to print from Microsoft Word, proceed as follows.

1

Open the document you want to print.

2

Select Print from the File menu.

Select “Panasonic KX-FLM600/650” as the
active printer.
≥If you want to change the printer setting, click
[Properties]. The printer setup dialog box will
appear.
You can change the following settings;
Resolution, Orientation, Paper Source,
Copies and Paper Size.
For details, see page 12.

4

Set the Page range and enter the number of
copies.

5

Click [OK] in the Print dialog box.

≥The Print dialog box will appear.

Note:
≥For details about the printer driver, use the Help function.

10

3

≥The unit will start printing.

Printer
Printing a selected file
You can print a specific file created with an application.

1

Open the PANA LINK main panel.

2

Click [Print] in the main panel.

3
4

Select the file you want to print.

≥The Open dialog box will appear.

Click [Open] in the Open dialog box.

Printing from Windows 3.1
You can print the documents from the Windows 3.1applications.
For example, to print from Write, use the Print command from the File menu.

1
2

Open the document you want to print.

3

Click the Setup button.
≥The Print Setup dialog box appears.

Select Print from the File menu.
≥The Print dialog box appears.

≥By clicking Options in the Print Setup dialog
box, the Panasonic KX-FLM 600/650 dialog
box appears. You can change the printer
settings: Grayscale Settings, Graphics Options
Toner Save and Halftoned Text.

4
5
6

Click the OK button.
≥The Print dialog box appears again.
Set the Print Range and the Copies.

Click the OK button.
≥Starts printing.

11

PC Software

≥The unit will start printing.
≥If an application which creates the file starts,
follow the instructions for the application to
print the file.

Printer
Setting up the printer driver
Panasonic KX-FLM600/650 dialog box

1
2
3
4

6
7
8
9
:
;

5

1 Resolution: Choose print quality
600dpi: Use this setting to print documents with 600 dpi quality. Print speed may be slow.
300dpi: Use this setting to print documents with 300 dpi quality. (When choosing this, you cannot change
“Graphics Options” in the Options dialog box.)
2 Orientation: Click these buttons to set the print orientation.
Portrait:
Use this setting to print in tall format.
Landscape: Use this setting to print in wide format.
3 Paper Source: You can set how to feed paper. Choose the follow options from the Paper Source Setting
drop down list box.
Standard tray feed: When selecting this option, you can not select Exec, COM-10 and DL in the Paper
Size.
Manual sheet feed: When selecting this option, you must feed paper into the unit by hand, one sheet at a
time
4 Copies: Use this setting to make multiple copies of the same document. Enter the number of copies (up
to 250) to be printed.
5 Paper Size: You can set the paper size. To choose the paper size, click the follow buttons.
Letter:
Standard US paper size [8.5 x 11in.]
Set the recording paper size to “Letter” on the unit
Legal:
US legal-sized paper size [8.5 x 14in.]
Set the recording paper size to “Legal” on the unit
Exec:
US executive paper size [7.25 x 10.5 in.]
A4:
Standard European paper size [210 x 297 mm]
Set the recording paper size to “A4” on the unit
COM10: Standard US envelope size [4.125 x 9.5 in.]
DL:
Standard European envelope size [220 x 110 mm]
6 OK: All options you changed are saved, and then close the dialog.
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Printer
7 Cancel: Cancel the option setting operation for KX-FLM600/650, then close the dialog.
8 Options: The Options dialog box appears. You can set further details.
9 Default: Back to the default settings.
: About: Display the version information of KX-FLM600/650.
; Help: Display help.

Options dialog box
When clicking the Options button in the Panasonic KX-FLM600/650 dialog box, the Options dialog box
appears.

3
4
1

5
6
7

2

8
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1 Grayscale Settings: Adjust contrast and brightness of the printing image.
Brightness: Use this setting to make the printed image lighter or darker overall.
Contrast:
Use this setting to control the range of difference between the light and dark areas of the
pictures.
Note:
≥The Brightness/Contrast settings may not change the print result in some cases. (For example, a textonly document.)
2 Graphic Options: Choose one of the following options depending on an original document type or the
purpose to print.
Text:
Use this setting when the document is mostly text.
Basic Graphics:
use this setting to print simple charts and graphics.
Complex Graphics: Use this setting to print detailed line art.
Photo:
Use this setting to print shaded images.
Note:
≥When setting the Resolution at 300dpi, you can not change “Graphics Options”.
3 OK:

All options you changed are saved, and then close the dialog box.

4 Cancel:

Cancel the option setting operation for KX-FLM600/650, then close the dialog box.

5 Default:

Back to the default settings.

6 Help:

Display help.

7 Toner Save: Use this setting to use less toner. Shaded areas will be lighter.
8 Halftoned Text: Use this setting to print color texts as gray.
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Printer
Printing using the paper tray (manual feeding)!
Using the printing manual feed, you can print on media other than letter or legal size plain paper.

Media you can print on
∫ Media size

∫ Paper weight

Media
Paper

Transparency
Envelope

Size

Dimension

∫ 60 g/m2 to 105 g/m2
(16 lb. to 28 lb.)

12

Letter

216 mmk279 mm (8 ⁄ qk11q)
12

Legal

216 mmk356 mm (8 ⁄ qk14q)

A4

210 mmk297 mm

Executive

184 mmk267 mm (71⁄4qk101⁄2q)

Letter

216 mmk279 mm (81⁄2qk11q)

A4

210 mmk297 mm

COM10

105 mmk241 mm (41⁄8qk91⁄2q)

DL

220 mmk110 mm

Loading a sheet manually
Important:
≥You cannot load two or more sheets at one time.

1
2

Close the paper tray extender.
Press (START/SET/COPY) and confirm the
following message.
Display:

Paper tray
extender

READY TO PRINT

(START/SET/COPY)

3
4
5
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Place a sheet on the paper tray with printing side
face down and align the edge of the sheet to the
guide marks.
≥The sheet should not exceed the tabs on both
ends of the paper tray.

Tab
Guide marks

Tab

Slide the sheet into the unit until it is stops.
≥A few seconds later, the unit will feed the sheet.
To print, change the Paper Source setting in the
printer setup dialog box to Manual Sheet Feed
(p. 12).

Guide marks
SIDE TO BE
PRINTED
FACE DOWN

Printer
Note:
≥Manual feeding is not available for receiving or copying documents.
≥Do not load a sheet while the unit displays the following message.
Display:

PLEASE WAIT

≥If you load another paper on the paper tray when the fax machine is feeding the paper, a paper jam may
occur. When you print two or more sheets, place a next sheet one by one after confirming the message
indicating to insert a sheet on your PC.
≥If printing is not performed for 20 minutes after loading a sheet on the paper tray, the sheet will automatically
be ejected.
≥Please read a README file (README.WRI) in the CD-ROM for more information.

Printing from Windows application
You can feed recording paper manually to print. The procedures are as follows.

1
2
3

Open the file you want to print on your
computer.

4

Select Manual sheet feed from the Paper
Source drop-down list box, and then click
[OK].
≥The Print dialog box appears again. If
necessary, set the Page Range and the
Number of Copies.

5

Press (START/SET/COPY) on the fax
machine and confirm the LCD message
“READY TO PRINT”.

6

Place a sheet on the paper tray with facing the
printing side down (p. 12).
≥You can feed recording paper only one by
one.

7

Click [OK].
≥The fax machine will start printing.

8

The Manual Feed Required dialog box
appears when printing of each page is
completed.

Select Print from the File menu.
≥The Print dialog box appears.

≥If you want to cancel printing, click [Cancel].
≥If you want to continue to print:
A. Place a sheet on the paper tray again.
B. Click [Close].
The Manual Feed Required dialog box
disappears. Start printing the next page.
*Even without clicking the Close button,
printing is started automatically in a few
seconds after a sheet is placed on the tray.
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Click [Properties].
≥The Panasonic KX-FLM 600/650 dialog box
appears.

Scanning
Transparencies and labels
You may also print on labels and transparencies that are made for the printer. Panasonic has tested and found
that the following work satisfactorily.
Transparencies

3M CG3300, 3M CG5000

Labels

Avery 5160, Avery 5161, Avery 5162
Avery 5163, Avery 5164, Avery 5165,
Avery 5167, Avery 5168
Xerox LWH100, Xerox LWH110, Xerox LWH120
Xerox LWH130, Xerox LWH140

Note:
≥With any label, the labels must completely cover the backing material (see below).
≥Re-using transparencies that have been fed through the printer once (for example, after jams or if the
transparency is ejected without being printed) can reduce the life of the consumables and paper path
components.
≥Some types of paper, especially transparencies are made to print on a specific side. If the print quality is poor,
try printing on the other side.

YES

Labels cover the entire
backing material.
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NO

The backing material is exposed.

Printer
Envelope specifications
We recommend that you purchase only high quality envelopes with diagonal seams, as shown in the diagram
below:
High quality envelopes have the following
characteristics:
≥A thin, sharply creased leading edge
≥Paper weight of 90 g/m2 (24 lb.)
≥Flat, free of curls, wrinkles, nicks, etc.
Note:
≥Wrinkles may occur in some cases, even if high quality envelopes are used.
We recommend that you do not use envelopes with any of the following characteristics (using these
may result in paper jams):

Side seam
construction

Peel-off strip Multiple flaps

Twist

Curl

Bent-edge

Wave

Dog-ears

Self adhesive

PC Software

≥Irregularly shaped envelopes
≥Envelopes with curls, wrinkles, nicks, twists,
dog-ears or other damage
≥Envelopes with side seam construction
≥Highly textured envelopes, or with extremely shiny
surfaces
≥Envelopes that seal by removing a peel-off strip
≥Envelopes with more than one flap to be sealed
≥Self-adhesive envelopes
≥Envelopes that are baggy or not sharply creased
≥Embossed envelopes
≥Envelopes that have previously been printed on

Do not attempt to print on any of the following types of envelopes (these may cause damage to your
printer):
≥Envelopes with clasps, snaps or tie strings (see Fig. 1)
≥Envelopes with transparent windows (see Fig. 2)
≥Envelopes that will melt, discolor, scorch, offset or release
hazardous emissions when exposed to 200 oC (392 oF) for
0.1 second
≥Envelopes that use encapsulated types of adhesive that do not
require moistening but rely on pressure to seal them

Fig. 1

Fig. 2

Always test a sample of the envelopes you are thinking of buying. Confirm that the envelope performs
acceptably.
For best printing results
≥Avoid printing in high humidity i.e., above 70 %.
High humidity may cause the envelope to curl and pick up excess toner.
High humidity may also cause the envelope to seal.
≥Avoid printing below 10 oC (50 oF) with less than 30 % relative humidity.
Low temperature with low humidity may cause light printing.
≥Print only one envelope at a time.
Envelope storage is very important. Store them away from moisture and humidity, where they can lay flat and
their edges will not be bent or damaged. The humidity should not exceed 70 % RH.
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PC Fax
Sending documents created on the PC!
Sending a document created by an application as a fax
message
You can access the fax function from a Windows application by using the Print command in the File menu.
Select PANA LINK FAX as the active printer.
For example, to send a document created from Microsoft Word, proceed as follows.

1
2

Open the document you want to send.

5

Set the fax number you want to send the
document to.
≥To set the telephone number, you can use
the keypad, one-touch dialing or the address
book.

Select Print from the File menu.
≥The Print dialog box will appear.

Keypad

3
4

Select PANA LINK FAX as the active printer.
Address book
Click [OK] in the Print dialog box.
≥If the PANA LINK application has not started
yet, it will start now, and then one item is
added to it as the transmission document.

6

One-touch
dialing

Click [START] in the main panel.
≥The document will be sent.

Note:
≥If the line is busy or there is no answer, the PANA LINK Fax will automatically redial the number up to
5 times.
≥To cancel transmission after dialing, click [STOP] in the main panel or press (STOP) on the fax machine.
≥If you send a fax using a PC, the FaxSav service cannot be used.
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PC Fax
Sending a file from the PANA LINK window

1

Open the PANA LINK main panel.

4

Select a file you want to send, and then click
[Open].
≥An image of the file will be displayed in the
preview window.

2

Click [Send\a\fax] in the main panel.
≥The Send fax panel will be displayed.

5

Set the fax number which you are going to
send the file to.

Keypad

3

Click [Browse] in the Send fax panel.
≥The Open file dialog box will be displayed.

Address book

6

One-touch
dialing

Click [START] in the main panel.
≥The document will be sent.
≥If an application which creates the file starts,
follow the instructions for the application to
send the file.

Note:
≥If the line is busy or there is no answer, the PANA LINK Fax will automatically redial the number up to
5 times.
≥To cancel transmission after dialing, click [STOP] in the main panel or press (STOP) on the fax machine.
≥If you send a fax using a PC, the FaxSav service cannot be used.
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≥To set the telephone number, you can use
the keypad, one-touch dialing or the address
book.

PC Fax
The PANA LINK FAX Properties dialog box
This dialog box has three tabs as follows.

Paper tab

Graphics tab

1 Paper size: You can set the paper size. To
choose the paper size, click the follow buttons.
Letter: Standard US paper size [8.5 x 11 in.]
Legal: US legal-sized paper size [8.5 x 14 in.]
Exec: US executive paper size [7.25 x 10.5 in.]
A4:
Standard European paper size
[210 x 297 mm]

1 Resolution
Specifies the resolution you want for graphic
images. Generally, higher resolution settings
produce higher quality printing; however, your
documents may take longer to print.
Select the desired resolution according to the
type of document.
Standard (200 x 100dpi)
Fine (200 x 200dpi)
Super Fine (200 x 400dpi)

2 Orientation: Click these buttons to set the print
orientation.
Portrait:
Use this setting to print in tall
format.
Landscape: Use this setting to print in wide
format.
3 Paper source: You cannot change the Paper
source.
4 Media choice: You cannot change the Media
choice.

20

2 Dithering
Specifies the type of dithering used in printing.
For color printing, dithering blends pure colors
into patterns to simulate a wider range of colors.
For example, orange is produced by blending
red and yellow. For non-color printing, dithering
produces gray shading in graphics.
None:
click this if you do not want any
dithering.
Coarse:
click this if your resolution setting is
300 dpi or higher.
Fine:
click this if your resolution setting is
200dpi or less.
Line Art: click this if your graphics include
well-defined borders between black,
white and gray shadings.

PC Fax

Device Options tab

PC Software

Error
Diffusion: click this for printing photographs or
pictures that do not have sharp,
well-defined edges.

1 Print quality
Specifies the text quality you want to use for
your printed document.

3 Intensity
Specifies how dark to print graphics in your
document.
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PC Fax
Sending a document from the fax machine
using the PC!

1

Place the document on the fax machine.

FAC

4

Click [START].

5

Set the image quality, type and brightness,
and then click [Scan].

≥A dialog box to set the image quality, type
and brightness will be displayed.

E DO

2

3

WN

Open the PANA LINK main panel.

Set the fax number you want to send the
document to in the main panel.
≥To set the telephone number, you can use
the keypad, one-touch dialing or the address
book.
Keypad

Address book
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One-touch
dialing

Note:
≥To cancel transmission after dialing, press (STOP)
on the fax machine.
≥If you send a fax using a PC, the FaxSav service
cannot be used.

PC Receiving
Receiving faxes on your PC!
You can receive a fax on the computer.
The received facsimile document is saved as an image file (TIFF-G4 format), and which you can view, print or
send again.

To receive manually
You can receive manually during a telephone conversation.

1

Open the PANA LINK main panel.

Click [START] in the main panel.

2

Open or minimize the PANA LINK main panel.

PC Software

2

To receive automatically
You can receive faxes to your PC automatically.

1

Set the fax machine to the AUTO ANSWER
mode by pressing (AUTO\ANSWER).
AUTO ANSWER
FA X ON

ON (RED)

23

PC Receiving
To receive directly to the fax
machine
If you do not want to be disturbed by incoming faxes
when using the PC, but want to receive faxes
directly to your facsimile machine, follow these
steps.
1. Click [Setup] in the main panel.
≥The Setup dialog box will appear.
2. Click the Reception tab in the dialog box.
3. Click “Receive directly to facsimile unit”.
4. Click [OK].

Confirming the result of reception

1

2

24

Open the PANA LINK main panel.

Click on the reception icon ([New\doc.]) in
the main panel, or click on [Comtn.\Log] and
switch to the received log.

3

Click on the items in the received log which
have not been viewed yet (
icon).

4

Click on File in the menu bar, then click on
View, or click [View] in the toolbar.
≥The Viewer window will appear, and the
received fax will be displayed.

Phone Call
Making a phone call!
You can place a phone call using PANA LINK.
Use the handset on the fax machine to talk.

1

Open the PANA LINK main panel.

3

Click [Dial].

4

Lift the fax machine’s handset.

≥The main panel indicator will display “Lift the
fax machine’s handset to talk.”.

Handset

2

Enter the telephone number in the main panel.

PC Software

≥You can select the telephone numbers using
the following methods: Keypad, one-touch
dial, address book or redial.
The main panel indicator will display “Start
calling by pressing the <Dial>.”.
Keypad

Address book

One-touch
dialing
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Address Book
Computerized directory for fax and phone
numbers!
The Address Book is your personal information database for fax and phone numbers.

1

Open the PANA LINK main panel.

3

Select New entry from Edit menu or click
[New\entry] in the toolbar.
≥A dialog box to register personal information
will appear.

2

Click [Add.\Book] in the main panel.
≥The Address Book window will appear.

4

Enter personal information in each space.

5

Click [OK].

≥The name is essential.

≥The registered information will be shown in
the list.

Broadcast
When sending the same document to more than one location, you can use the “Group” function in the Address
Book. You may select as many locations as you want from the Address Book.
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Scanning
Using your fax machine as a scanner!
Scanning from Windows 95/98
Create an image file (TIF format) by scanning the document which is set in the fax machine.

1

Set the document which you are going to
scan, in the fax machine.

FAC

E DO

3

If necessary, change the setting of Image
Quality, Image Type and Brightness.
For details, see page 29.

5

Click [Scan].

6

To save the scanned image, select Save as
from the File menu.

≥The Viewer window will appear after
scanning, and the scanned image will be
displayed in it.

Open the PANA LINK main panel.
PC Software

2

WN

4

Click [Scan] in the main panel.
≥The Scan dialog box will appear.

Note:
≥To cancel scanning while the document is being
scanned, press (STOP) on the fax machine.
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Scanning
Scanning from Windows 3.1
To scan a document into you PC as an image file, you need an application which contains the scanning feature
such as Visioneer PaperPort®.

1

Set the document you are going to scan on
the unit.

4

Select FLM600/650 Scanner 16 in the Source
list box, and then click the Select button.

2

Start Visioneer Paper Port.
≥The Visioneer PaperPort window appears.

5

Select Acquire from the File menu.
≥The FLM 600/650 Scanner 16 dialog box
appears.
If necessary, change the setting of Image
quality, Image Type and Brightness.

3

Select Select Source from the File menu.
≥The Select Source dialog box appears.

6

Click the Scan button.
≥The scanned document is displayed in the
Viewer window after scanning.

7

To save the scanned image, select Export
from the File menu.

Note:
≥To cancel scanning while the document is being scanned, press (STOP) on the fax machine.
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Scanning
FLM 600/650 Scanner 32
The FLM 600/650 Scanner dialog box is displayed when you click the Scan button on the PANA LINK Main
panel.

4

1

2

3

5

6

7
PC Software

You can set up the following items to make an image file better.
1 Image Quality: You can set the image quality to scan.
Fine (200 x 200 dpi):
For a text document with small writing or a document with a simple graphic.
Line art (400 x 400 dpi): For a document with complicated graphics or very small text. (400 x 400 dpi:
interpolated)
2 Image Type: You can set the image type to scan.
Auto: Sets the image type automatically.
Text:
For a text document. (We recommend this as a default.)
Photo: For a photograph.
4 Status: shows the current state of the unit.
The following messages are displayed depending on the state of the unit.
State

Message
Ready

A document is set on the unit. Please click the Scan button for
scanning.

Please insert document to
scan.

A document is not set on the unit. Please set a document on the feeder
tray.

Scanning

The unit is scanning a document.

FLM600/650 unit power is off.
Plug the unit in and try again.

The power of the unit is off or unplugged, or the PC is not connected
to the FLM600/650. Please verify above.

FLM600/650 is warming up.

The unit is warming up. Please wait for a while.
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Scanning
3 Brightness:
Normal:
Light:
Very Light:
Dark:
Very Dark:

You can adjust brightness by using the slider.
Brightness is not adjusted. You can adjust the brightness based on the result of this scan.
Use this when scanning a dark document.
Use this when scanning a very dark document.
Use this when scanning a light document.
Use this when scanning a very light document.

5 Scan: To start scanning.
You can use this button only when a document to be scanned is set.
6 Cancel: Close the FLM600/650 Scanner dialog box.
7 Help: Display help.
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Copier
PC based copying!

1

Set the document which you are going to copy
in the fax machine.

FAC

E DO

2

Enter the number of copies required in
Number of copies.

5

If necessary, change the setting of
Enlarge-Reduce.

6

Click [Start].

7

If necessary, change the setting of Image
Quality, Image Type and Brightness.

8

Click [Scan].

≥The Scan dialog box will appear.

Open the PANA LINK main panel.

Click [Copy] in the main panel.

PC Software
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4

≥The fax machine will start scanning the
documents, then will print the copies.

≥The Copier dialog box will appear.

Note:
≥To cancel copying while the document is being
scanned, press (STOP) on the fax machine.
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More Information
The Communication Log!
It is possible to view a list of faxes sent or received from the PC, and to view their contents.
It is also possible to forward or resend these faxes.

1

Open the PANA LINK main panel.

2

Click [Comtn.\Log] in the main panel.
≥The Communication Log window will appear.

3

Select the Communication Log Folder.
≥The content of the selected Communication
Log Folder will be displayed in the
Communication Log List.

Communication
Log Folder

Communication
Log List

Note:
≥As the transmitted image files will remain in the hard disk, please check regularly that there is enough free
space.
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More Information
Viewer!
≥It is possible to display the images sent, received, or scanned with PANA LINK.
≥It is possible to move, copy and delete a file or page.
≥From the Viewer, it is also possible to send an image as a fax.

1

Open the PANA LINK main panel.

3

Click on File then Open in the menu bar, or
click the Open icon in the tool bar in the main
panel.
≥The Open window will appear.

2

Click [Viewer] in the main panel.
≥The Viewer window will appear.

Select the file you want to view.
PC Software

4

Note:
≥Text on the image cannot be edited.
≥Use OCR to convert text on the image to text data that can be edited with word-processor software.
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More Information
PC link!
(turning PC related functions on/off)
The PC LINK feature by default is “ON”.
If the AUTO ANSWER mode is turned on, all faxes will be received at your PC automatically.
If you do not want to be disturbed by incoming faxes when using the PC, but want to receive faxes directly to
your fax machine, do one of the following.
—Turn off the PC LINK on the fax machine.
—Select “Receive directly to facsimile unit” on the PC (p. 24).

To turn off the PC LINK on the fax machine
≥When this feature is off, operations from your PC, such as fax transmission/reception, scanning, printing or
copying are not available.

1

Press (MENU).

2

Press (#), then (1) (4).

3

Press (START/SET/COPY).

4

Press

/
Display:

PC LINK

MODE=ON
or

▼▲

to select “OFF”.
MODE=OFF

▼▲

≥To turn on the PC LINK on the fax machine,
select “ON”.

5

Press (START/SET/COPY).

6

Press (MENU).
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MENU

1.SYSTEM SET UP

SETUP ITEM [

]

START/SET/COPY

Troubleshooting
When a function does not work, check here
before requesting help!
General
Problem

Cause & Remedy
≥Point at an area with no buttons or parts and drag it where you
want to move.

I do not know whether the PANA
LINK Main Panel is active or not.

≥The brightness of the Main Panel Display shows you whether the
PANA LINK Main Panel is active or not.
<Active – bright, Non active – dark>

A Quick tip does not appear when I
hold the mouse pointer over a
button in the PANA LINK Main Panel,
although I have set to display this.

≥If the PANA LINK Main Panel is non-active, the quick tip does not
appear. Confirm again after making the PANA LINK Main Panel be
active by clicking anywhere on it.

The telephone number set in the
Main Panel Display disappears, and
the display shows “It is used for
specifying the dial data.”
explanation of the button and so on.

≥The quick tip is displayed. Move the mouse cursor out of the PANA
LINK Main Panel. If you do not need quick tips, open the setup
dialog and select OFF of the Quick Tip in the System tab.

The PANA LINK Main Panel
disappears.

≥Look in the task tray (in the task bar). If you do not find the PANA
LINK icon, it is closed. If you find the icon, the PANA LINK Main
Panel is just minimized or iconified.
Double-click the icon in the task tray or open the menu by
right-clicking the fax icon then select Restore.

The PANA LINK Main Panel
disappears just after initializing.

≥The PANA LINK Main Panel is set to minimize when PANA LINK
starts. Double-click the icon in the task tray or open the menu by
right-clicking the fax icon, then select Restore.
If you do not want this to happen each time you start PANA LINK,
press the Setup button in the PANA LINK Main Panel, and check
off the Start minimized check box in the Program startup settings in
the System tab.

I want to delete all of the telephone
numbers set in the Main Panel
Display.

≥Press the Stop button.

I cannot recognize the last part of
the entry in the address list of the
Address Book or Communication
log, because that part ended with...

≥Put a cursor on the line between the buttons, the cursor changes
shape and you can expand the area by dragging, or
double-clicking.

A cover page is sent whenever I
send a fax, though I do not want to
send it.

≥The setting of the cover page is ON by default. To deactivate the
setting, open the Setup dialog box by pressing the Setup button,
and click the "Default Add cover page at every transmission"
check box in the Cover page tab.

I attempted to select a telephone
number from the Address Book to
the PANA LINK Main Panel, but I
selected a fax number by mistake.

≥You can change your selection in the PANA LINK Main Panel.
Double click the number you set in the Main Panel Display, the fax
number switches into the telephone number. You can also
right-click the entry to select a specific number.

I cannot use the Dial button, even
though I specified a telephone
number.

≥If there is transmission data or a document is set in the fax, you can
only use the fax transmission function. If you want to make a phone
call, please delete the transmission data.
(continued)
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I do not know how to move the
PANA LINK Main Panel, because
there is no title bar.

Troubleshooting
General (cont.)
Problem

Cause & Remedy

When I exit PANA LINK, the Viewer
does not close.

≥The viewer can be operated separately, so when the PANA LINK is
closed, it remains open.

The PANA LINK does not work
properly.

≥Click the
button to exit PANA LINK, and restart.
If PANA LINK does not closed, please force it to close by pressing
Ctrl+Alt+Delete keys.

I cannot send or receive a fax
through PANA LINK.

≥When you use a PC with an ECP printer port such as a Compaq
Deskpro or an IBM Aptiva, you may need to change the ECP port
into a standard port:
1. Click the Start button, point the Settings, then Control Panel.
2. Double-click System.
3. Double-click Ports [COM & LPT] from the Device Manager tab.
4. Double-click ECP Printer Port (LPT1).
5. Click the Update Driver... button on the Driver tab.
—The Update Device Driver Wizard starts.
6. Click the “NO, select driver from list” button.
7. Click Show all hardware and choose Standard Port types
from the Manufacturers list, and Printer Port from Models.
8. Click the Finish button.
If you are required to insert the Windows 95/98 CD-ROM, please
do the following.
1) Insert the Windows 95/98 CD-ROM. The Copying files dialog
box appears.
2) Click the Browse button, and then choose Win95/98 folder
from the list.
3) Click the OK button. The Version Conflict dialog box appears.
Please check Your version here. If it is 4.00.955, click Yes.
You may need to change the ECP port in the BIOS system
settings. It varies by PC, please refer to your PC operating
instructions or manufacturer for instructions.
Please verify the LPT.VXD version is 4.00.955:
1) Click the Start button, point to Settings, then Control Panel.
2) Double-click System, and then open the Device Manager tab.
3) Double-click Ports [COM & LPT] from the Device Manager tab.
4) Double-click Printer Port (LPT1).
5) Click the Driver tab. Verify whether the File version is
4.00.955.
Note: If it is an old version, you must uninstall PANA LINK first,
then reboot the PC, and re-install it again.

I cannot open a TIFF file.
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≥You must change the compression format of the file. For example,
to convert an image using WANG Imaging, proceed as follows:
1. Click on the Start button, point to Programs – Accessories,
then click Imaging.
2. Open the TIFF file that you cannot open in the PANA Viewer.
3. Open the Page menu, then click Convert.
—The Convert dialog box appears.
4. Click the Compression tab, then choose [CCITT Group 3 (1d)
Modified Huffman] from the Compression drop-down list.
5. Click the OK button.
—The file’s compression format is changed.

Troubleshooting
Printing
Problem
I cannot print.

Cause & Remedy
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≥Please verify the following.
1. Driver settings: If you change the driver settings in the
Panasonic KX-FLM600/650 dialog box, you may be able to print.
2. Preview window: If the image is not properly displayed in the
Preview window, your file may contain errors. Try printing a
different file. Also, there may be a problem with the application
you are using.
3. Bad connection between PC and printer: Verify the printer is
properly connected and plugged in.
4. Re-install: Uninstall PANA LINK, reboot your PC, then re-install
it.
5. Port setting: If the printer port is not set to FLM600, you cannot
print.
1) Click the Start button, point to Settings, then Printer.
2) Choose Properties from the printer’s pop-up menu.
—The Properties dialog box appears.
5. 3) Click the Details tab, and check the Print to the following
port drop down list box. If a different port is selected,
re-select FLM600 (KX-FLM600 port).
5. 4) Click the OK button.
6. Bi-Directional Parallel Port. (ECP mode): If using ECP
(Extended Capability Port) mode, you may not be able to print.
Please change it into a standard port:
5. 1) Click the Start button, point to Settings, then Control Panel.
5. 2) Double-click System, and then open the Device Manager
tab.
5. 3) Double-click Ports [COM & LPT] from the Device Manager
tab.
5. 4) Double-click the ECP Printer Port.
5. 5) Click the Update Driver... button from the Driver tab.
5. 6) Change the ECP Printer Port into Printer Port (LPT1).
If the same error occurs repeatedly even after changing the printer
port, check the BIOS settings or update LPT.VXD. Please refer
your computer manufacturer for the latest LPT.VXD and the BIOS
settings. LPT.VXD version 4.00.955 is required. If you do not use
the correct version, we cannot guarantee that the driver will work
properly.
Reboot your PC, and try to test printing.
1) Click the Start button, point to Settings, then Printers.
2) Choose Properties from the printer’s pop-up menu.
—The Properties dialog box appears.
3) Click the Print Test Page button from the General tab.
If the same error occurs, please see next.
Please verify the LPT.VXD version is 4.00.955:
1) Click the Start button, point to Settings, then Control Panel.
2) Double-click System, and then open the System Properties
dialog box.
3) Double-click Ports [COM & LPT] from the Device Manager tab.
4) Double-click Printer Port (LPT1).
5) Click the Driver tab. Verify whether the File version is 4.00.955.
Note: If it is an old version, you must uninstall PANA LINK first,
and then restart the PC, and re-install it again.
When you change settings manually, you must reboot your PC.

Troubleshooting
Transmission
Problem

Cause & Remedy

I see a “Sending the fax ended in
failure.” message.

≥Possible causes are as follows.
—Telephone circuit is not good.
—You received a call-waiting signal.
—The other party stopped reception.
—The other party ran out of the recording paper.
Transmit again after confirming with the other party.

I see a “No response” message.

≥The other party did not answer the call or the line was busy.
Transmit again after waiting a while.
≥The dialing mode setting (tone or pulse) is not correct.
Open the Setup dialog box and confirm the dialing mode setup
check box in the Line tab.

I cannot make an international
transmission.

≥Set the fax machine to the overseas transmission mode.

Reception
Problem

Cause & Remedy

The fax machine receives a fax, but I
want to receive it with the PC.

≥You probably checked the [Receive directly to Facsimile Unit]
check box to activate in the Reception tab in the Setup dialog box.
If so, click this check box to deactivate.
≥The setting of the PC LINK on the fax machine is off. Turn it on
(p. 34).
≥The PANA LINK application does not operate. Start the PANA LINK
application.

The PC receives a fax, but I want to
receive it with the fax machine.

≥Open the Setup dialog box, then check the [Receive directly to
Facsimile Unit] check box to activate in the Reception tab.

I want to print out the received fax
with another printer.

≥Print after selecting the desired printer from the Print dialog box.

The “Fax reception ended in
failure.” message is displayed.

≥Possible causes are as follows.
—The line condition was not good.
—The reception was interfered with the call waiting signal.
Check with the other party and try again.

Scan and copy
Problem

Cause & Remedy

I cannot scan.

≥The facsimile unit is probably busy. Try again after the other
operation is completed.
≥There might be not enough free space on the hard disk. Try again
after deleting unnecessary files or closing unused applications.
≥There might be not enough RAM. Try again after closing some
applications.
≥Restart the PC, then try again.

The document is not pulled into the
document feeder.

≥Confirm that a maximum of 15 pages are set correctly.

A document is jammed.

≥If you select Fine (200 x 200 dpi) in the image quality list, make
sure the document is less than 655 mm (257⁄8q). If you select Line
Art (400 x 400 dpi), make sure the document is less than 470 mm
(181⁄2q). Remove the jammed document and try it again.
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Troubleshooting
Scan and copy (cont.)
Problem

Cause & Remedy

The recording paper is jammed.

≥Remove the jammed recording paper and reset it, then try again.

Even after clicking the Cancel
button, scanning continues.

≥Wait. Sometimes, it takes a while for the cancel request to be
accepted.

I cannot scan documents using
other applications.

≥Due to compatibility issues, an error may occur when you scan
documents using certain applications. Scan from PANA LINK.

Error message
Problem

Cause & Remedy

“Initializing ended in failure” is
displayed.

≥Reconfirm the connection of the PC and the fax machine.
≥The setting of the PC LINK on the fax machine is off. Turn it on
(p. 34).

Print quality
Problem

Cause & Remedy
≥Some paper has instructions recommending which side to print on.
Try turning the paper over.

The printing is faint.

≥You may have used paper with a cotton and/or fiber content that is
over 25 %, such as letterhead or resume paper.
≥The remaining toner is low. Replace the toner cartridge.

Original

Copy

ABC
A dirty pattern or a black line
appears on the printouts.

≥There are scratches on the drum unit. Replace the drum unit.
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The printing quality is poor.

